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Installation

Q: Howdo linstall Ambit Optimist 77?

A: You should have received an email from SunGard Inmatrix that contains a download URL of our
latest version of the Ambit Optimist 7 software. Click the attached URL. You will then be

mol jmgbaYqgl Y¥Lmbkz) Y¥PAsb+)Yl oY¥@ 'k bi+x2YY@ f hY¥P~s

Once the download is comp lete, navigate tothe downlo * abaYc |l i ab o Yf kY ¥pevtheA |
¥>mmi f ‘foldgrfrlkkasY¥ i f ° h Y¥ p b q Ambit DptimistY q 1 Yf kpgnii ¥

Note : Before proceeding with the installation of Ambit Optimist, we recommend that you
review the Release Notes and the Installation Help by clicking on the Application
Documentation Folder. The installation needs to be run by a user with administrator
privileges on the local workstation. During the installation process, we recommend that you
accept all of the suggeste d responses to the questions asked. After installation, the
workstation should be rebooted and the first time Ambit Optimist 7 is run, it should be done
so by an administrative user.

You will then need to register the software within 31 days of the initial installation. After this
time, the software will cease functioning until it has been registered. Follow the instructions in
the Registration section of the Installation Help. The help file (V7install.chm) is copied to the
install directory at installation. You will also need the Registration Name and N umber provided
by SunGard Inmatrix.

To run the program, locate the Ambit Optimist shortcuts on your Windows Start Menu. Ambit
Optimist will prompt you for a user name and password. The default user name is "Admin" with
no password. Administrative users can change or add users within the Ambit Optimist
Administration module.

Q: | have installed AmbitOptimist _r qYf gYt |l k$gYork+YLKivYqgeb)

module is working.

A: This issue may occur if you are running Windows 7 as your operating system. In this case,
there are some steps you need to take in addition to the procedure described above to install
Ambit Optimist 7 successfully.

Once you have installed Ambit Optimist 7, in Windows Explorer, navigate to the program
installation directory ( C:/Program Files/Ambit L mq f j f p q Y 4 &OptW.axed Y~ K agb Y ¥
¥OptimistAdmin.exex + Y ¥dihl exetutables, you will need to adjust the properties.

To do this:
1. Right mouse button click on the executable and selec t Properties .

Select the Compatibility tab.

2
3. Under Privilege Level ) Ypbi b  qYgqebVY¥OrkYgefpYmoldo”j Y *pY~KkY™aj
4

Click Apply to save the changes.
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Note : This must be done for both executables (OptV7.exe and OptimistAdmin.exe). If this is
not done for OptV 7.exe, the Ambit Optimist application will n ot run. If it is not done for
OptimistAdmin.exe, any changes made in the Administration module wi Il not be saved to the
database.

Adjusting the properties for the executables will ensure that Ambit Optimist 7 and the Ambit
Optimist Administration module work correctly when running Windows 7.

Q: lam trying to configure the connection as part of installing an SQL Server
a~g”™ _~“pb)Y_ rqYgebY¥OrkxY |jj~"kaYfpYklqY~rsAf
menu. How do | complete this step of the installation instructions?

A: In Windows 7, the Run command is not displayed in the Start menu. To access the Run
command using Windows 7, p ress the Windows logo key + R.

If you wish to add the Run command to the Start menu, you can do this through the Start Menu
Properties. See Microsoft Windows Help and Support for more information.

Q: During installation, | receive an error message that CFX4032.0CX did not
self-register or unregister in Windows 7.

A: In some versions of Windows 7, this error message may be received when installing
Ambit Optimist 7. To fix this problem, Ambit Optimist 7 should be installed in Windows XP SP2
(or higher) compatibility mode. To do this, complete the following:
First, ensure that the folder containing the Ambit Optimist 7 installation files is read/write.
1. Right-click on the installation folder and select Properties .

2. Inthe General tab, next to Attributes , ensure the Read-only check box is NOT selected.

Next, reinstall Ambit Optimi st 7.
1. Navigate to the installation setup.exe.

2. If Ambit Optimist is currently installed, double -click the setup.exe and select Remove to
remove the application.

Right-click setup.exe and select Troubleshoot compatibility
Select Try recommended settings .

Cf "hY¥Pg~ogYgebYmol do”j3+VYql YpgroqYgebYpbgr m+bub

o o &~ w

Continue with the Ambit Optimist 7 InstallShield Wizard and follow the prompts to
complete the installation of Ambit Optimist 7.

7. Restart the computer as directed by the install wizard.
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Registration

Q: How do I register Ambit Optimist 7 after a new installation?

A: When you first log into Ambit Optimist after a new installation, the software will display the
Product Activation form.

¥ Product Registration

Activation

This is an unreqistered program. Use of this program should be on a
termporary basis for evaluation purposes only, IF this program is ko be used
for purposes other than evaluation please reqgister this pragram,

Details For reqistration can be Found in the Read Me file and in the 'Register’
dialog box on the help menu.

The current product registration will expire on 05-Mov-2010.

Uze 30 Day Tnal Penod

Cancel |

Click Register and follow the prompts to register the software. Yo u will need the User Name
and Password provided to you by SunGard Inmatrix to register the software.

Instructions are available in the Registration section of the Installation Help. The help file
(V7install.chm) is copied to the install directory at insta llation.

Q: How do I register Ambit Optimist 7 after the trial period has expired?

A: To use the software after the trial period has expired, you need to register the software.
To register the software you need:

A the User Name and Password provided to yo u by SunGard Inmatrix; and
A an active internet connection.

If you do not have an active internet connection on the computer on which Ambit Optimist is
installed you will need to complete a Manual registration. Referto Completing a Manual
registration below for instructions.

If you do have an internet connection on the computer on which Ambit Optimist is installed, you
can complete an Automatic registration.

Note: For Network versions, contact your software vendor for instructions .
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Completing an Automatic registration

When you start the software after the trial has ended, the software will display the Product
Activation form .

Note: To access the Activation form before the trial period has ended, simply go to the Help
menu in Ambit Optimist and select Register.

¥ Product Registration

Activation

This is an unreqgistered program. Use of this program should be on a
temporary basis for evaluation purposes only, IF this program is ko be used
for purposes other than esvaluation please register this program.

Details For reqistration can be Found in the Read Me Fle and in the 'Register'
dialog box on the help menu.

The current product registration will xpire on 05-Mov-2010.

ze 30 Day Tnal Penod

Cancel |

1. Click Register to continue with registration of the software.

The Registration Details are displayed.

% Product Registration b
.

Registration Details

Carmpuker Marne: RSKP-MEL-CE
Serializakion Code: 10419010419714D107
Status: The current product regiskration will expire

on 28-0ck-2010,

Serialzation Code & ol fo be wred for sfandaine mnstatation froes.

= Back. | Mext = I Cancel

2. Click Next.
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¥ Product Registration x|
|

Registration Type

There are three types of Registration: Automatic; Manual; and Mebwork,

Click Mext For Automatic Registration of your software over the Inkernet
(recommended).

Click Advanced For Manual or Mebwork Registration, Use Advanced, if vou
have already obtained a Skandalone or Mebwork Reqg.bin File,

Advanced... |

Cancel

< Back |

Note: If you do not have an internet connection on the computer on which the software is
installed, you will need to com plete a Manual registration . Refer to Completing a Manual
registration below for instructions.

3. Click Next.
The Login page is displayed.

¥ Product Registration x|

|
Login

User Marme: |

Paszword: |

: Cancel |

< Back |

4. Enter the User Name and Password that were provided to you when you received the
software.

Note: If you have misplaced your User Name and Password, contact your software vendor.

5. Click Next.

The Confirmation of Details page is displayed.
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W Product Registration x|

- Confirmation of Details

Campany': Inrnakriz
First Mame: IJuhn Address 1; |1,|'33 Park St
Last Marme: |Smith Address 2: |
Pharne Ma: |I:|3968E-?444 Suburb: |Sc:uth Melbourne
Faix Mot |0z9ss67466 State: jv1c
Ernail: |Juhn.5mith@practice.cor PostCode: |32E|5
Counkry: |.ﬁ.u5tra|ia
< Back | Mext = | Cancel

6. Complete the online registration form. Ensure you complete all fields on the form and that
the address details are completed corr ectly.

7. Once all fields have been completed correctly, click Next .

The Registration Complete page is displayed confirming that the software registration was
successful.

¥ Product Registration x|
o

Registration Complete

The product has been successfully registered.

< Barch | g

; Cancel |

8. Click Finish.
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Completing a Manual registration

You need to complete a Manual regis tration if you do not have an internet connection on the
computer on which Ambit Optimist is installed. This involves obtaining a Reg.bin file from the
software vendor. To do this, complete the following steps:

1. Start Ambit Optimist on the computer on wh ich itis installed. When you start the software
after the trial has ended, the software will display the Product Activation form .

Note: To access the Activation form before the trial period has ended, simply go to the
Help menu in Ambit Optimist and select Register.

¥ Product Registration

Activation

This is an unregistered program. Use of this program should be on a
temporary basis For evaluation purposes only, IF this program is to be used
for purposes ather than evaluation please reqgisker this program.

Details For registration can be found in the Read Me file and in the ‘Regisker’
dialog box on the help menu.

The current product registration will expire on 05-Mow-2010.

Usze 30 Day Tral Peniod

Cancel ‘

2. Click Register.

The Registration Details are displayed.

% Product Registration x|
|

Registration Details

Computer Marme: RSEP-MEL-CE
Serislization Code: 104190104197140107
Skatus: The current produck: registration will expire

an 29-0ck-2010,

Serialzation Code & anly fo be wed for standalone insfalation éoes.,

< Back | Mext = I Cancel

3. Make a note of the Serialization Code.

© 2010 SunGard



AMBIT OPTIMIST 7 FREQUENTLY ASKED QUESTDNS

Before continuing with the registration, you need to obtain the reg.bin file from  the
software vendor. You do this on the SunGard website; therefore, you need a computer
with an active internet connection.

4. On a computer with an active internet connection, open the web b rowser and go to
www.inmatrixinc.com or www.inmatrix.com.au .

5. Gotothe Registration page.

6. Enter the User Name and Password that were provided to you when you received the
software and click Login.

Note: If you have misplaced your User Name and Password, contact your software vendor.

7. Ensure all mandatory fields are completed and thatt he information is correct, enter the
Product Serialization Code and click Continue .

SUNGARD 'NMATRIX - CREDIT RISK MANAGEMENT

E SALES CONTACTS

+1-800-685-1773

PRODUCT REG|STRAT|ON inmatrix.info@sungard.com
Australia

Please enter the following information to activate your product(s): +61-3-9686-7444

Company: Inmatrix inmatrix.info@sungard.com

First Name: * Jane Address 1: * Level 2

Last Mame: * Jones Address 2: 33 Park Street Improve risk adjusted
performance through

Phone: * 0396867444 City/Town: * South Melbourne Dttar ending deceians

Fax: * 0396867466 Post/Zip Code: * 3207 mt R: > w’i

Email: * jane_jones@sungard com State: * Victoria
. Click here to visit the

Country. Australia Ambit Creit Risk
PRODUCT SERIALIZATION CODES MATADRISGL e 318

Product Serialization Code u PRESS RELEASES
@ Optimist 7 1D41901D41971AD107 SunGard Acquires Inmatrix »

Feb 5, 2010 — Melbourne,

Australa

MNote: Please use cut and paste to minimize errors, when entering product Serialization Code.
A star (*) indicates 2 mandatory field.

icy Terms of Use SunGard Final

A registration file (reg.bin) will be emailed to the emai | address provided. You will need this
file to be on the computer on which Ambit Optimist is installed to complete the
registration.
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8. On the computer on which Ambit Optimist is installed, at the Registration Details page
(which displays the Serialization Code), click Next .

The Registration Type page is displayed.

x|
- Registration Type

There are three bypes of Registration: Automatic; Manual; and Metwork,

Click Mext For Automatic Regiskration of your software over the Internet
{recommended).

Click Adwanced For Manual or Metwaork Registration. Use Advanced, if you
have already obkained a Standalone or Metwark Reqg.bin file.

Advanced... |

Cancel

% Back |

9. Click Advanced .
The Registration File page is displayed.

¥ Product Registration

Registration File

Select Registration file type, Standalone or Network (Reg. bin):
{+ Standalone
" Metwork

Please select the product registration file (Req.bin)

Registration File: |

% Back Cancel

10. Select the Registration file type ©Standalone or Network .

11. Click the ellipsis button next to the Registration File field, then navigate to and select the
reg.bin file.

12. Click Next.
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The Registration Complete page is displayed confirming that the software registration was
successfu.

¥ Product Registration x|

-~ Registration Complete

I The product has been successfully reqgistered.

= Back |

Cancel |

13. Click Finish.

Q: Irecently changed computers, reinstall ed Ambit Optimist 7, but the
Inmatrix Inc. website tells me my User Name and Password has already been
used?

A: Once a User Name and Password has been used to register the software , it is locked to
prevent multiple registrations. You will need to contact SunGard Inmatrix Support for assistance:
By email:  Inmatrix.Support@sungard.com
By phone: USA 800-685-1773

Asia Pacific 1300 300 838

Once unlocked, you will be able to re -register your copy of Ambit Optimist 7.
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Common Error Messages

Q: When | start Ambit Optimist 7, | receive the error message ¥Optimist has
bk I rkqgbobaY”Y theodpplidaton clo¥es k a
A: This error is caused by MS Vista and Windows 7 User Account Control (UAC) settings.

If using MS Vista, to resolve the problem you need to turn off UAC. To do this, select Start
menu > Control Panel > User Accounts > Turn On or Off User Account Control , then click
Turn off UAC. (You will be asked to restart the PC).

If using Windows 7, to resolve the problem you need to adjust the User Account Control

settings. To do this, select Start menu > Control Panel > User Accounts and change the setting
to the third or bottom posit ion. Windows 7 provides four levels of security for UAC. The
bottom setting turns off all UAC.

If you still encounter the same problem:
1. In Windows Explorer, navigate to the application path.

For version 7.3 this is usually CAProgram Files\Inmatrix Solutions\Optimist 7;
for version 7.6 and above this is usually C:\Program Files\Ambit Optimist 7.

2. Right-mouse button click on the OptV7.exe and select Properties.
3. Select the Compatibility tab.

4. Pbi b qgYgebY eb h_| uY¥O0OrkYqgef pY moseteai thg Wirfddw¥ ~ | j m~ g f
XP option in the drop -down list below.

5. Pbi b’ qY dghislprigia® mskan administrator + check box.
6. Click OK to save the changes.

Q: When | start Ambit Optimist 7, | receive the message ¥ Kr | _db o
LicencbopYe”~pY _ _bbkYbu bbabaz++

A: This message will occur when more than the allowed number of users attempt to start the
application. This message will also occur if you attempt to start the software more than once for
a single user licence.

If you believe the number of current users does not exceed your licen ce permissions, this error
can be rectified. To resolve the issue, first shut down the application, t hen navigate to the
program installation directory and delete the RORC.vfn and RORC.vfx files. *IMPORTANT! Do
not delete RORC.vdt **

Note : These files may be hidden. To view them, open MS File Explore, click the Tools menu

and then Folder Options . Navigate to the View tab and select the ¥Show Hidden Files and
Folderst Y  eb > hY | u+
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Q: When | start Ambit Optimist 7, | receive themesp* db Y¥Fks~i faVY | kkb
settings. Please contactyor oY>aj f kf pgo”~ gl o=+ +

A: This message indicates that you are not connected to the Ambit Optimist 7 database file or
Database Server. You will need to contact your local IT department to resolve the problem.

Q: When | start Ambit Optimist 7, | receive the error message ¥ Or kqf j b 'Y
bool oY1/ 67Y>" qgqfsbYUY@ j ml. KHowkdo Mesdiviethig?Y >  ob” qby

A: Ambit Optimist is built using Microsoft common components and sometimes these
components may be out of date, not present or not properly registered on the computer on
which the application is installed, causing issues for the current build of our software. To resolve
this problem:

1. Make sure Ambit Optimist is closed.

2. Make sure Optv7.exe is not present in t he Task Manager.

3. Make sure the user has Administrative privileges.

4. Install the Microsoft MSXML4 SP2 or later (see Microsoft website):

(MSXMLA4) http://www.microsoft.com/downloads/details.aspx?familyid=3144B72B -B4F2-
46DA-B4B6-C5D7485F2B42&displaylang=en

5. Install the Microsoft MDAC 2.8 or later (see Microsoft website):

(MDAC 2.8)
http://s upport.microsoft.com/downloads

and search for Microsoft guidelines for MDAC for your operating system and the latest
service pack.

N7YYFYt~pYrk”~ _ ibvYaq
@ jm kbkqY *"k$qY o
without showing the login screen.

cfuYgebYbool oYjbpprdbVYy¥
qb Y|l _ g bplashsscYearbcmses f _ba Y " _

A: This error may have occurred following an upgrade from an earlier version of Ambit Optimist .
To resolve this problem:

1. Make sure Ambit Optimist is closed.

2. Make sure Optv7.exe is not present in the Task Manager.
3. Make sure the user has Administrative privileges.

4. Locate and re-register the following Microsoft component:

c:\Windows \ System32\msscript.ocx
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Q: When I click the Ambit Optimist 7 icon, | receive the message ¥ Qe f p
product has an invalid | icence. Please contact software d istributor or refer to
your installation note s on how to renew your licenc b + +

A: If you have a valid Ambit Optimist 7 licence, please contact SunGard Inmatrix Support for

assistance:
By email:  Inmatrix.Support@sungard.com
By phone: USA 800-685-1773

Asia Pacific 1300 300 838
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Using Ambit Optimist ©Data Topics

Q: How do I import previous Excel spreads into ~ Ambit Optimist 7?

A: Ambit Optimist 4 Yf pYbnr f mmbavvi gexdDo¥¥BerqY ~"kY_bYrpbavYqly
spreads into an Ambit Optimist 7 format. The Excel Loader can be located in the Templates
folder: C:/Program Files/ Ambit Optimist 7/Templates.

Q: Is there sample data | can use to learn more about ~ Ambit Optimis t 7
functionality?

A: Yes. Asample spread comes preloaded with Ambit Optimist 7. It can be located in:
C:/Program Files/ Ambit Optimist 7/Sample Data/Becca_2006.0pt.

Q: How do | share the Ambit Optimist 7 database with other users?

A: See the Ambit O ptimist Installation Help file (V7install.chm) located in the Ambit Optimist 7
install directory (C:/Program Files/ Ambit Optimist 7).

Q: lam unable to locate the Ambit Optimist 7 file | recently created. Where
are the Ambit Optimist 7 files saved?

A: Ambit Optimist 4 Ycf i bpYbkaYt f qe Y dmtit Dftimist b7 Kilpsfate kaved todaliy g + +
ql YgebYr pbo$p VY | j mrn@lodatibade.ilflyqupr¥ pnabde hodo¥atelyour: saved

.opt file, you can use the Search feature on your computer, searching for the file extension (.opt)

or the file name.
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Using Ambit Optimist ©General Topics

Q: Howdo lloginto Ambit Optimist 7?

A: In most cases, users can log nto Ambit Optimist 4 Y _v Ybkgbof k d Adment Wrrpoa o’k ~ j b Y ¥
password is needed. In cases where users have been assigned specific roles, contact your
program administrator or IT for log in instructions.

Q: Is detailed information available for the formulas Ambit Optimist 7 uses?

A: Yes. Formulas can be found in multiple ways in Ambit Optimist 7. The Help menu contains
many calculation explanations, which are easy to locate using the Search function. For example:

Calculation
EBIT = Gross Profit - Operating Expenses - Other Expenses/(Income)

Detailed Calculation

EBIT = Revenue - COGS - Operating Expenses - Other Expenses/(Income)
Quick Tips

EBIT is a key component of Profitability % and RONA %

Within the Analysis screens of Ambit Optimist 4 ) Y¥ &g+ Yebi mYf p Y " ippvidest s~ f i ~ _i by
calculations and detailed analysis comments.

Within the Strategy and Explore screensof Ambit Optimist 7, formula calculations are displayed
in the bottom left corner of the screen.

N7YYTebkY "kYFYrpbYqgebyY¥ dmitOmmidcak gqfl ki fq

A:¥Umboq+YfpY~Yebi mYcr k Anpliysis kcregns. "ToeYplirposerokttiisrfeatorey g | Yge b Y
is to provide information about each particular Analysis screen, how important information is
calculated and some tips for trend analysis.

Once you have clicked on the Analysis tab in the navigation bar, go to the Help drop -down
jbkrYrkaYpbib gY¥Umboqgq++YYQebY¥Umboqg+YtfkaltYtfiiVY~r
screen and will change for each screen as you scroll through them.

Q: Where can | find calculations of ratio measurements within ~ Ambit
Optimist 77?

A: When you are in the Strategy screen, simply click on any ratio measurement and then look at
the bottom left corner of the Ambit Optimist 7 screen. In the status bar just under the Report
tab, you will be able to see the calculation for the ra tio chosen.

Also, the Help function allows you to search for different info rmation found within Ambit
Optimist 7, including calculations of ratio measurements.
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The last two pages of the Financial Diagnostic Report include a listing of ratio definitions as  well
as a glossary of terms, which makes it a great reference document for the user as well as for their
clients.

Q: I have loaded three years of financial statement data for a client. All of
the numbers reconcile to the financial statements themselves, however,
there is still a difference, which  is shown in red at the top of my  Ambit
Optimist 7 model. Why is my statement not balanced?

A: When loading data, it is important to be aware of how the Income Statement and Balance
Sheet numbers are inter-related. Ambit Optimist 7 requires that financial statement periods in
one model be contiguous because of the treatment of Retained Earnings.

There are three separate detail lines within Accumulated Retained Earnings. One | ine pulls
information from the Incom e Statement and the other will pull from the prior year accumulated
retained earnings. The final line is simply for adjustment s to Retained Earnings. NOTE: The lines
that pull directly from another location in the model cannot be overwritten or changed.

When loading data in the first period of a spread , you must be aware that the previous balance
must be entered manually ©this is the only period in which a manual entry can be made for that
line item. To properly do this you will need either the prior pe riod closing balance or an opening
balance for the period being loaded as period one.

Q: What is the difference between Chart Templates and Industry Templates?

A: ¥Chart Template * refers only to the account headings that appear on the Loading Screen
under the Income Statement and Balance Sheet, as well as items on the Strategy Screen. Ambit
Optimist 7 allows for the creation or modification of Chart Templates through the Administration
module of the software.

Industry Templates allow for a means of cate gorizing not only Chart Templates, but also related
KPls, Benchmarks, and Worksheets that are relevant to a particular type of industry.

Q: Is there a way to refer back to the amounts that were added together in
a single cell on the Loading Screen?

A: If you click on the cell in question and then look at the top of the screen, you will see a white
bar with the numbers that have been added together to get that result. This calculation
reference will be saved at the same time that you save the data file .

Q: I have created an Account Note and checked the box to add it to the
Income Statement Report, but it does not show up on the screen. What am |
doing wrong?

A: Any time you associate an Account Note with a report, it will always show up on page 2 o f
that report. In order to scroll to the different pages of any report, you will need to use the up
and down arrows on the toolbar rather than the scroll bar on the side of the screen.
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Q: Is there a way to print multiple reports at one time?

A: When you are in the Reports tab, there is a button on the toolbar entitled Consolidate
Reports. Click this button to select reports you would like to consolidate. When reports are
consolidated, you can then print these togeth er as one report. You can also use the Export
Report button to save the consolidated report in one of several different formats, including .PDF
format.

While the Export R eport function is only obvious on the pages in the Report tab, you can print or
export ANY Ambit Optimist screen by clicking the print icon. After doing so, that page is
formatted to look like all other Ambit Optimist reports. At this point , you can either print the
page or export the page to one of the available formats.

Q: Reports are not working in - Ambit Optimist 7.

A: If Reports are not visible in Ambit Optimist 7, this may be because certain components failed
to register when the software was installed on a computer running Windows 7. To fix this
problem, Ambit Optimist 7 should be reinstalled by a user with an Administrator account type.
To do this:

1. On the local machine, log on as Administrator.
2. Navigate to the installation setup.exe.

3. If Ambit Optimist 7 is currently installed, double -click setup.exe and select Remove to
remove the application.

4. Install Ambit Optim ist 7.

Q: When | select Reports in  Ambit Optimist 4) YFYdbqY~Yj bpp~rdbY¥VI
i b*pgqY-Ypg™rgbjbkgpYqgl YsfbtYgefpYobmloqg+=
A: If you are unable to see certain reports in  Ambit Optimist , such as the Income Statement and

Balance Sheet, and this message isdisplayed, your printer may not be correctly configured. To
resolve this:

1. Ensure the local or network printer is your default printer.

2. Check the setting for your default printer so that printing starts after the last page was
spooled.
A From the Control Panel, select the default printer.
A Right click and select Properties .
A Select the Advanced tab.
A BkprobYgebY eb' hyY
¥PgroqYmof kqgf k n

_lubpYcloY¥PmlliYmofkqgYa
cgboYi“"pgYmrAdbYfpYpmllib
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+
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Using Ambit Optimist ©Analysis Topics

Q: How can benchmark data be accessed and analyzed within ~ Ambit
Optimist 77?

A: There are several ways in which you can usebenchmark data to analyze information within
Ambit Optimist .

You must first select a benchmark by clicking the Tools drop-down menu and then choosing the
Benchmark option. The first option is to Select a Benchmark. Once that has been completed,
there are three distinct views for the utilization of that data in your analysis.

The traditional means of utilizing the d ata is in report format. By selecting the Report tab, you
can scroll to the Benchmark reports. You will then be able to choose either a variance report or
a common size report with the relevant benchmark data embedded.

Ambit Optimist 7 also provides a uniqgue means for comparing benchmark data. While in the
Strategy screen, you can turn on the Benchmark Monitor and get a quick comparison by color-
coded lights that display next to certain measurements on the screen. To turn on the Benchmark
Monitor in the Strategy screen, select Tools menu > Benchmark or simply click the bulls eye icon
on the toolbar.

For RMA data that has been purchased and imported, the data already comes color -coded
following these rules: a green light corresponds to the top quartile of  peer data, a yellow light
corresponds to the middle two quartiles, and a red light corresponds to the bottom quartile.

You may also add your own benchmark data by utilizing the Benchmark option in - Ambit Optimist
7 Administration.

Q: How can an adjustmen t be made in the Explore view if anitem (  e.g.
Operating Expenses) is not variable in nature?

A: If you are looking to keep operating expenses static despite any potential revenue increases,

you may manually calculate what the resulting percentage of reve nue would be and key that in

as a percentage number in the appropriate field.

VIirY ~kY”~iplYmbocloj Y*"Y¥Te~rqYFczxY~kaYqgebkYj"hbYpmb" f
statements once the changes have been accepted into the model.
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N7YYFYmbockopbWRY2YEDBkpfgf sfgvYgbpgY~*kaYqgebk
to adjust some of the line items. When | click back to the Strategy screen, |

NP Yrk™ _ibYqgl Y¥rkal £YjvY e*kdbp+YYTerqVY ~kY
original numbers?

A: Any time you make a change and then leave the Strategy screen, the changed data is now )
considered the base model and youarenolongbo Y i bYql Y¥rkal tYqe”~"qY e~kdb+

When you make changes in the Strategy screen, if you do not intend to change the base model
data, you MUST¥ r k a | + Y ngestBEFORE you navigate away from the Strategy screen.

This is one of several cases where consistent data management techniques are helpful. Because
Ambit Optimist 7 includes so many robust options for stress testing, you will always have the
option to change, create and save new models. For this reason, it is highly recommended that
any files with critical data be saved to a backup folder so that work does not have to be
replicated.

Q: How can | include interim statements in  Ambit Optimist 7?

A: The optimal way to manage interim financial statements is to load them into separate models
so that they can be utilized in a variety of ways. By creating separate files for each, it is easy to
compare any interim periods or add interim financial statements to an annual file utilizing either
the Views or Model Comparison options on the Tools drop -down menu.

The primary difference between the Views and Model Comparison options is that Model
Comparison, by default, will only allow the latest period in  the selected model to be viewed in a
report. When the Views option is chosen, you have the ability to choose what periods and from
what models you would like to view in your final report format.

Q: I have been stress testing one of the models that | created and | notice
that each time | make changes , the Short Term D ebt account also changes. |
have not specifi ed or called for any change to Short Term D ebt. What is
happening?

A: The Short Term Debt account in Ambit Optimist 7 is the balancing account within the
software. Each time changes are made to a model, whether through stress testing or creating
projections, one of two things will occur.

Either there is the generation of excess cash to the business, or the need for additional funding
based on business performance. Those changes both net out in the Short Term Debt line,
regardless of whether there is a funding need or the creation of additional cash. You may
actually notice a negative short term balance in cases where the changes to the model would
actually create additional cash for the company.

It is equally important to note that , even though the change has been netted out in Short Term
Debt, you have complete control to make adjustments to your model so that the flow does not
automatically go into Shor t Term Debt. This requires a manual adjustment to be made in the
Loading Screen.
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Note: The precise location for the balancing within Short Term Debt actually occurs on the
first child (detail) line within the Short Term Debt account heading. To find th at level of detail,
i f hYl kYgebY¥(+xYpfdkYql YbumrkaY~kaYpbbYqgebYabqg~fiop

It might be helpful to change the child line items in your chart of accounts so that the balancing

i f kbVYt | ri aYWnabo¥dted Diffeence+. That line by default has Short Term Debt as the
heading. In this case, simply shift the Short Term Debt to the bottom of the list on one of the
blank lines. Doing so will allow you to isolate the balancing account for any changes that are
made to the model. T his way you have complete control over the changes being made and can
quickly and easily identify the actual dollar amount of the impact of your change.

N7YYTevY ~k$qYFYpbbYgebY I sbkAkgY |l jmif~rk b
covenant report?

A: The covenant report i s intended to be a summary for the most recent period in the model. In
order to quickly access prior period covenant reports, the simplest means of doing so would be
to export each model period report and save it as a .PDF or .RTF file.

Q: Isthere a way to use the Strategy s creen for periods that are not the
most recent two periods in my model?

A: The Strategy screen only takes into account the two most recent periods of data in your
model. In order to use the Strategy screen for periods prio r to this, you would need to delete
the more recent periods so that the last two periods in the model are those you want used in the
Strategy screen, and save this as a new model.

To simplify this process, as you create a model, you could save each new period added as a new
file for quick access. For example, your model initially includes data for 2006, 2007 and 2008 ©
save that model as XYZ Company FYE 2008. When you add a period for 2009, click Save As
rather than Save and give that new model a name lik e XYZ Company FYE 2009.
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Administration

N7YYFYe~rsbY bbkYqovfkdYql Y  ob"gqbY2YHMFYO”"qf
the line item that | need in order to create that measurement.

A: Within the KPI Ratio screen, you can select a Chart Templateand b ~ > e Y¥ d ‘adba £ Yi f kb Y

item within that Chart Template is available to be selected to be included in a KPI Ratio. If you

require additional line items, we recommend that you modify the Chart Template to include the

line item in the template. Once you hav e done this, the line item will be available for selection to
be part of a KPI Ratio.

N7YYFYe~sbYj~abY e~kdbpYfkYqgebY>ajfkfpqgo~rqf
changes in Ambit Optimist 7.

A: This will occur if you are running Windows 7 and you did no t adjust the properties of the
OptimistAdmin executable after you first installed Ambit Optimist 7. If the Opt imistAdmin.exe
properties are not adjusted, changes made in the Administration module will not be saved to the
database and, therefore, will not app ear in Ambit Optimist 7. This is only an issue for users of
Windows 7.

To resolve the issue, complete the following steps:

1. In Windows Explorer, navigate to the program installation directory ( C:/Program
Files/Ambit L mq f j f p q Y 4 & OptikistAdimin.exeig+h Y ¥

2. Right mouse button click on the executable and select Properties .

3. Select the Compatibility tab.

4. Under Privilege Level ) Ypbi b  qYgebY¥OrkYqgefpYmoldo”j YrpY~rkY™aj
5. Click Apply to save the changes.

This will ensure that the Ambit Optimis t Administration module works correctly when running
Windows 7.
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